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Abstract

The purpose of the INTIMATE project is to integrate palaeo-climate information
from terrestrial, ice and marine records so that the timing of environmental response
to climate forcing can be compared in both space and time. One of the key difficulties
in doing this is the range of different methods of dating that can be used across
different disciplines. For this reason, one of the main outputs of INTIMATE has
been to use an event-stratigraphic approach which enables researchers to co-register
synchronous events (such as the deposition of tephra from major volcanic eruptions)
in different archives (Blockley et al., 2012). However, this only partly solves the
problem, because it gives information only at particular short intervals where such
information is present. Between these points the ability to compare different records
is necessarily less precise chronologically. What is needed therefore is a way to
quantify the uncertainties in the correlations between different records, even if they
are dated by different methods, and make maximum use of the information available
that links different records.

This paper outlines the design of a database that is intended to provide integration
of timescales and associated environmental proxy information. The database allows
for the fact that all timescales have their own limitations, which should be quantified
in terms of the uncertainties quoted. It also makes use of the fact that each timescale
has strengths in terms of describing the data directly associated with it. For this
reason the approach taken allows users to look at data on any timescale that can
in some way be related to the data of interest, rather than specifying a specific
timescale or timescales which should always be used. The information going into the
database is primarily: proxy information (principally from sediments and ice cores)
against depth, age-depth models against reference chronologies (typically IntCal or
ice core), and time-transfer functions that relate different timescales to each other,
through the use of event stratigraphies or global phenomena such as cosmogenic
isotope production rate variations.
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1 Introduction

The purpose of the INTIMATE initiative is to make independent comparisons
of the timing and duration of abrupt climatic changes over the last 60 ka by
facilitating the comparison and integration of marine, terrestrial and ice core
records (Blockley et al., 2012). Lowe et al. (2008) suggest that within the IN-
TIMATE approach individual studies should generate proxy data with their
own robust chronologies for well-resolved sites and then define the local and/or
regional climatic events. Once this has been achieved comparisons can then
be drawn between other sites and, for example, the Greenland event stratigra-
phy. However, this may only be attempted when the full range of stratigraphic
and chronological uncertainties present in all comparable sequences are con-
sidered. Without this structured approach chronological uncertainties within
and between records hinder the testing of competing theories surrounding the
mechanisms of abrupt climate change (Lowe et al. 2008). For this reason it is
necessary to quantify the uncertainties in the correlations between different
records and make maximum use of the information that is available to link
records. A process for achieving this is outlined below and has been integrated
into visualisation software for the wider community, thereby facilitating the
INTIMATE approach to palaeoclimatic research.

Central to any questions of timing and duration is the definition of timescales.
Some timescales are useful as main reference timescales which can be used to
allow direct comparison of ages from different records; in this category are the
IntCal calibrated radiocarbon timescales (Reimer et al., 2009, 2013), and the
Greenland GICC05 timescale (Andersen et al., 2006; Rasmussen et al., 2006,
2008; Svensson et al., 2006, 2008). Importantly, information on the relation-
ship between these primary timescales is also available, based on the compar-
ison of globally synchronous variations in the radionuclide production rates
(Muscheler et al., submitted). However, if data are only referenced against
these common timescales, with proper accounting for the full chronological
uncertainties, it becomes difficult to study duration and relative timing of cli-
matic and other events. Therefore, it is important also to maintain site-specific
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timescales because, fundamentally, proxy data are provided against depth and
the local timescale provides a convenient way to look at data at high-resolution
with units that do not depend on deposition rate. The approach taken here is
to allow all data to be observed relative to any time or depth scale with all
of the associated uncertainties. The aim is to provide a tool (available online
at https://c14.arch.ox.ac.uk/intimate/db.php) to quickly explore data
from different perspectives so that researchers can better understand what the
available data reveal about past climate change.

The work presented here arises out of two scientific meetings supported by
the EU-funded COST (European Cooperation in Science and Technology)
INTIMATE initiative. The first of these was a workshop held at Oxford in
December 2012 which looked at different ways of presenting data and consid-
ered how best to use the relationships between different timescales. This was
followed by the INTIMATE meeting at Blair Atholl in April 2013 where the
INTIMATE group as a whole helped to pull together the information which
is held in the database described here. These meetings provided an opportu-
nity to pool information in ways that had not been possible before, and to
start the process of compiling datasets. However, what is presented here is in-
evitably just the first stage in what must be a continuous process. This paper
specifically presents the mathematical basis for the integration of records and
explains how users might navigate through the database tool in order to add
and compare Late Quaternary records.

2 Mathematical methodology

In setting out the mathematical formalism for the approach taken here, it is
necessary to make a number of approximations and simplifications. This is
in part because of the complexity and range of the different datasets being
integrated, but it is also because it is useful to have a formalism for integration
that can be carried out rapidly as new data are included and does not require
a major remodelling effort as each new dataset is added.

The problem of complexity in the data is perhaps the most obvious. Much of
the information available is based on non-normal statistics (so, for example,
maximum counting errors in ice core ages, and proxy information expressed
in terms of depth ranges, rather than with a depth uncertainty). It would be
possible, in principle, to include all of this information into a mathematical
model and use a method such as Monte Carlo Markov Chain (MCMC) with
Bayesian formalism to combine all uncertainties. However, while this might
well be practical on a small scale, the other main problem is that, in principle,
every dataset is related in some way to every other dataset, and so as new
information is added everything should be reviewed and reassessed. Thus, the
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model required would have to encompass the full dataset and this is, at present
anyway, impractical.

For these reasons the method presented here breaks the integration process up
into a number of manageable stages and makes some simplifying assumptions.
This is a pragmatic approach which allows flexibility in the kind of information
included, but it does mean that there will be approximations made in the
process that users should be aware of from the start. The approach is one of
propagation of normal errors.

The methodology is perhaps most easily understood in terms of an example.
Supposing we wish to date a series of proxy samples in site A (for example
Kr̊akenes). The first stage might be to use an age-depth model, based on ra-
diocarbon, to provide a central estimates of age (tA) for the depths in that site;
this provides an internal site-specific timescale, useful for internal comparison
purposes. However, the central age estimates are ultimately derived from the
IntCal calibration curve (B) and, although the central estimate for the date
in this timescale (tB, the IntCal timescale) is the same, there is uncertainty
associated with it, which comes from the calibration and age-depth modelling
exercises; this uncertainty needs to be taken into consideration if comparisons
to other radiocarbon dated material is to be made. Furthermore, you might
wish to compare the data from Kr̊akenes to that from another record C (for
example the NGRIP record). This would require an estimate in the timescale
for that record (tC , which in this case is GICC05), requiring information on
the relationship between tB and tC .

2.1 Proxy information

The reason for the study of most environmental sites is the associated proxy
data. In general such data are collected from material in a core or section
and thus there is a direct relationship between the proxy data and the sec-
tion’s associated depth scale. Another complication is that many such cores
or sections have different depth scales (for example: individual core depth,
composite depth, or event-free depth). It makes sense for those with exper-
tise in the record itself to define the most appropriate depth scale to use.
However, it is also important to bear in mind what this depth will be used
for. In the methodology outlined here it will be assumed that between data-
points in an age-depth model it is possible to linearly interpolate age from
depth. This means that a single monotonic depth scale should be used and,
if possible, this should be an event-free depth (excluding layers attributed to
macroscopic, instantaneous deposits, e.g. from floods, turbidites, visible tephra
etc., see Schlolaut et al. (2012) and see Fig. 1) as this will give more accurate
interpolation.
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Fig. 1. The left hand plot shows common problems with age-depth relationships in
real sediments; it is important that these types of problem are identified and dealt
with either by using separate segments for records, or by using event-free depth
scales; the right hand plot shows what is required for this exercise in that age must
be a strictly monotonic increasing function of depth and vice-versa.

Our primary proxy data for a particular data series are given at specific points
in the record. Let the record be labelled A, the index corresponding to the
specific depth i and the actual (average) depth be zi

A; the central estimate
for this depth is given as hi

A with an unknown error from the true value
of ζ i

A. Typically sampling is perfumed over a depth range (defined as ri
A)

and so strictly follows a uniform distribution ζ i
A ∼ U(−ri

A/2, r
i
A/2). Because

the methodology used here relies on normal errors, this is approximated to a
normal distribution (N ) with the same variance.

zi
A = hi

A + ζ i
A (1)

ζ i
A∼N (0, (ri

A)2/12) (2)

∼N (0, (si
A)2) (3)

where si
A =

ri
A

2
√

3
(4)

The errors ζ i
A in zi

A are likely to be uncorrelated.

For each depth (index i) there might be a whole array of different proxy mea-
sures, each of which could have an uncertainty associated with it (quoted
within this database as a 1σ standard uncertainty). For display purposes
straight lines are drawn between successive datapoints and so it is impor-
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tant to remember to mark within the data series where there are gaps in data
(see section 3).

2.2 Age-depth models

In order for data series to be useful in this context, there must be an age-depth
model. These can be produced by different methods (see, for example, Blaauw
and Christen, 2005; Bronk Ramsey, 2008; Scholz and Hoffmann, 2011; Heaton
et al., 2013). The purpose of an age-depth model is to provide a functional
relationship for the age of a record against depth, based on the primary dating
information. Such a model will do more than simply interpolate between the
dated events, and any significant non-linearities in the age-depth profile should
be dealt with at the modelling stage. It is also essential that any such age-
depth model should have an uncertainty associated with it. Here, in order to
keep the algorithms simple, another assumption is made, and that is that the
age-depth model uncertainties can be adequately summarised by a mean and
standard uncertainty. In practice, many of the Bayesian methods employed
yield non-normal marginal posterior distributions but fortunately, for many
models where there is a high density of scientific dating information yielding
high-precision age-depth models, the age distributions for particular depths are
well approximated by normal distributions. Other methods such as Gaussian
process (GP) models (Heaton et al., 2013) give results in this form anyway. In
practice the uncertainties in any age-depth model are highly covariant (Heaton
et al., 2013; Bronk Ramsey and Lee, 2013), a point which will be discussed
below.

At this point it is necessary to introduce an important aspect of the integration
exercise, which is that the defined age-depth model is assumed to be related
to some reference time-scale (tB), or using a particular direct dating method.
For example the age-model might be based on a specific IntCal calibration
curve, an ice core chronology, or use a direct dating method such as Uranium-
Thorium dating. The relationship between these different methods of dating
is something that will be discussed further below (sub-section 2.3).

An age-depth model is, in principle, capable of yielding output at any required
resolution. In practice, the output from these models is only given at specific
depths (sometimes, but not always, the same as the best estimate depths, hi

A,
of the record). It is important that the output is sufficiently closely spaced
that it is possible to linearly interpolate between the output points to recover
a full functional relationship between depth and time (implying that any non-
linearities are small compared to the quoted precision of the age-depth model).
It is also assumed that the age-depth function is strictly monotonic, so that
an inverse can be defined, and differentiable. For any depth zA the age-depth
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model will be defined to be tA = fA(zA). This will be relative to the reference
timescale tB against which there will be an unknown time-dependent error
εAB(tA) (or depth-dependent as εAB(f(zA))). Thus:

tA = fA(zA) (5)

tB = tA + εAB(tA) (6)

It is useful to keep the concept of a local timescale tA which is essentially a
proxy for depth, but with the units of time, and which takes into account the
changes in deposition rate elucidated through the age-depth model. Even in
this timescale there is uncertainty in the age of proxy data if there is depth
uncertainty. Using a Taylor-series, to first order:

tiA = fA(hi
A + ζ i

A) (7)

≈ fA(hi
A) + f ′A(hi

A)ζ i
A (8)

tiA∼N (fA(hi
A), (f ′A(hi

A)si
A)2) (9)

The central estimate for the age in the reference timescale is the same, but
error is introduced. In order to anticipate the next stage of this process this
can be defined as a time transfer function GAB(tA) with a central estimate of
gAB(tA) = tA:

tB =GAB(tA) (10)

= gAB(tA) + εAB(tA) (11)

In addition to providing the central estimate of age against depth, fA(zA),
the age-depth modelling process will quantify the likely error εAB(tA). For
a single point estimate of age it is assumed that the error is quantified by a
time-dependent variance σ2

AB(tA) (which could also be considered to be depth-
dependent as σ2

AB(fA(zA)).

εAB(tA) ∼ N (0, σ2
AB(tA)) (12)

However, it should be noted that unlike the depth uncertainty, this error func-
tion is likely to be highly covariant: that is there will be a strong correlation
between εAB(tiA) and εAB(tjA) where tiA and tjA are close in value. This need
not matter when calculating single values but it must be kept in mind with
a whole series of calculations. One reason that this function must be highly
covariant is that the function GAB(tA) must be monotonic. Given that the
gradient of the central tendency is in this case exactly 1, the magnitude of the
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gradient in the error function εAB(tA) is expected to be � 1. Later it will be
assumed that the age-depth gradient defined by the age-depth model will be
approximately correct - a point which actually relies on the highly covariant
nature of the errors.

Example age-depth model application

The methodology so far will be illustrated with a specific example. The loss
on ignition (LOI) data from Kr̊akenes (Lohne et al., 2013) core 46 are given
for specific depths (zi

A). The age-depth model gives an estimate of the age
(and the associated uncertainty) against IntCal09 and outputs a value at 1cm
intervals, between which it is possible to interpolate linearly, giving a continu-
ous function fA(zA) (being the central estimate of the age-depth model). For
any depth zA in the Kr̊akenes core this function can be used to find the age in
the local timescale (tA). This timescale can be used to plot the LOI data, as
an alternative to plotting it directly against depth. By analogy this is similar
to the practice of plotting NGRIP δ18O data against the GICCO5 timescale.
To compare to any other site, it would also be possible to plot the Kr̊akenes
data against the IntCal09 timescale (tB). To do this it is necessary to take
account of the uncertainty in the age-depth model defined by the variance in
the age-depth model σ2

AB(tA).

Using age-depth models for proxy data

In general for any particular proxy at level zi
A, in a record which is calibrated

to the IntCal calibration curve (timescale tB), to first order in zA:

tiB = tiA + εAB(tiA) (13)

= fA(zi
A) + εAB(fA(zi

A)) (14)

= fA(hi
A + ζ i

A) + εAB(fA(hi
A + ζ i

A)) (15)

≈ fA(hi
A) + f ′A(hi

A)ζ i
A + εAB(fA(hi

A)) + ε′AB(fA(hi
A))f ′A(hi

A)ζ i
A (16)

Given, the covariant nature of εAB(tA) discussed above, the final term should
be small in comparison to the second and thus:

tiB ≈ fA(hi
A) + f ′A(hi

A)ζ i
A + εAB(fA(hi

A)) (17)

tiB ∼N (fA(hi
A), (f ′A(hi

A)si
A)2 + σ2

AB(fA(hi
A)) (18)

where the first element in the variance comes from the uncertainty in the
depth and the second from the uncertainty in the age-depth model.
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Fig. 2. Schematic showing how the database can be used to integrate records. Each
node can represent either a specific environmental record (such as that for the
site of Kr̊akenes, or GRIP), or a composite record/timescale (such as GICC05 and
IntCal). In the case of a composite record/timescale, this can contain proxy data
compilations, or simply be a timescale used for a number of different site-specific
records, thereby providing an important node for record integration.

2.3 Time-transfer functions

There are other ways in which different timescales can be directly related
to one another (see Fig. 2). Time scale transfer functions are usually based
on the identification of common events in different records. Transfer functions
are preferentially inferred from climate-independent and physically understood
linkages between proxies in different natural archives. For example, these in-
clude gas measurements in ice cores (as long-lived atmospheric gases are rela-
tively well mixed globally) or linkages via identification of tephra layers that
can be geochemically identified and unequivocally connected to one source. It
is also possible to relate the IntCal timescale (tB) to that of the Greenland ice
cores (tC) through comparison of 10Be and 14C variations (Muscheler et al.,
submitted), or the Greenland and Antarctic timescales through methane and
10Be synchronisation (Lemieux-Dudon et al., 2010). Less obviously, there is
information on the relationship between timescales whenever there are terres-
trial, marine or ice sites that share the same tephra.
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Mathematically, such relationships between two different timescales (tB and
tC) can be defined by providing point estimates of one timescale (tC) relative
to another (tB), and by quantifying the uncertainty in these relationships.
As for the age-depth models above, it is important that the method used to
generate this relationship outputs relative values at high enough density that
it is legitimate to linearly interpolate between points to give a continuous
function GBC(tB) with a central estimate of gBC(tB):

tC =GBC(tB) (19)

= gBC(tB) + εBC(tB) (20)

εBC(tB)∼N (0, σ2
BC(tB)) (21)

where σ2
BC(tB) is the variance. Again as above the function εBC(tB) is expected

to be strongly covariant for similar values of tB. When such a time transfer
function is applied to a record which has been age-depth modelled, this gives:

tC =GBC(tA + εAB(tA)) (22)

= gBC(tA + εAB(tA)) + εBC(tA + εAB(tA)) (23)

≈ gBC(tA) + g′BC(tA)εAB(tA) + εBC(tA) + ε′BC(tA)εAB(tA) (24)

The gradient of the function gBC(tB) will be approximately 1. For the same
reasons as discussed above, the function ε′BC(tB) should have a magnitude
� 1; or to put it another way, it is assumed that G′BC(tB) ≈ g′BC(tB). This
means that the final term in this equation is small in comparison to the second,
giving:

tC ≈ gBC(tA) + g′BC(tA)εAB(tA) + εBC(tA) (25)

tC ∼N (gBC(tA), (g′BC(tA)σAB(tA))2 + σ2
BC(tA)) (26)

To return to the specific example, this would allow the timescale of a particular
site like Kr̊akenes (tA) to be expressed in terms of the GICC05 timescale (tC)
given a functional relationship (GBC) between the IntCal09 timescale (tB) and
the GICCO5 timescale (tC). Indeed, for any point with an estimated depth hi

A

with uncertainty si
A in such a record, it is possible to define the age in terms

of three different timescales:
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tiA∼N (fA(hi
A), (f ′A(hi

A)si
A)2) (27)

tiB ∼N (fA(hi
A), (f ′A(hi

A)si
A)2 + σ2

AB(fA(hi
A)) (28)

tiC ∼N (fA(hi
A),

(g′BC(fA(hi
A))f ′A(hi

A)si
A)2

+(g′BC(fA(hi
A))σAB(fA(hi

A)))2

+σ2
BC(fA(hi

A))) (29)

where the first element in the variance comes from the uncertainty in the
depth, the second from the age-depth model and the third from the transfer
from timescale tB to tC . Conceptually, each change of timescale adds extra
variance to the age estimate.

Inverse functions can also be easily generated allowing, for example, data on
the GICC05 timescale to have age estimates in the IntCal timescale, in the
local timescale of a specific record like that of Kr̊akenes, or indeed on the
depth-scale of that core. The inverse time-transfer functions can be defined to
first order as:

tB =GCB(tC) (30)

= g−1
BC(tC − εBC(tB)) (31)

≈ g−1
BC(tC)− 1

g′BC(g−1
BC(tC))

εBC(g−1
BC(tC)) (32)

gCB(tC)≈ g−1
BC(tC) (33)

σ2
CB(tC)≈

(
1

g′BC(g−1
BC(tC))

σBC(g−1
BC(tC))

)2

(34)

Likewise, if the total variance in tA is given by σ2
A, then the central estimate

for the depth hA and its variance s2
A are given by:

hA≈ f−1
A (tA) (35)

s2
A≈

(
1

f ′A(tA)
σA

)2

(36)

In general the uncertainties associated with depth, with age-depth modelling,
and with time-transfer functions (such as that between IntCal and GICC05)
would be expected to be independent, which is an important assumption un-
derlying the methodology laid out here. This would clearly not be the case if
a conversion used the same time-transfer function (or its inverse) more than
once. In terms of the network shown in Fig. 2, it is then important that only
simple paths are used (i.e. no point is passed through more than once).
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One area where there may be some correlation that is not accounted for
is where two different records are independently calibrated to the IntCal
timescale using radiocarbon. Some uncertainties in such age-models come from
the calibration curve itself and thus are common to both. This is the same
problem that arises when comparing two calibrated radiocarbon dates more
generally. In practice, the data-density and precision of the calibration curve
mean that most of the uncertainty is record specific and this is not a major
issue, but this is none-the-less a limitation of current calibration approaches.

2.4 Integration

As seen in the previous section time-transfer functions can be used to trans-
form through a series of timescales (A → B → C). This can be thought of
as a network of connected records: the records being the nodes and the time-
transfer functions being the paths between nodes (see Fig. 2). In principle with
a fully connected network of records this enables any timescale to be related
to any other. However, there are some fundamental complications arising from
the network topology:

• In general there are many different paths in a network from one point to
another. Even if there were only ever one time-transfer function directly
connecting two nodes, there would generally still be multiple connections
involving one intermediate node or more (for example A → B → C → D
and A→ B → E → D).
• Because there is uncertainty associated with the transfer functions, and

approximations involved with them, each path taken will almost certainly
give a different solution.
• Some paths through the network might pass through the same nodes more

than once, and likewise the connections in the network (the time-transfer
functions) might be used in different paths.

All of the information imbedded within the network could be incorporated
into a global model for relating all of the timescales. However, this would
be a very significant computational task, as discussed above. At first it might
appear possible to simply transverse all possible paths and combine the results
analytically. However, the fact that this would involve different paths sharing
some of the same information means that all such estimates cannot be treated
as independent. For this reason, in this application an even simpler approach is
taken which is to take the value which gives the lowest uncertainty. This will
usually be the shortest route through the network since each time-transfer
function used introduces extra uncertainty. This will, if anything, tend to
overestimate the uncertainty.
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The algorithm employed is:

(1) Where relevant, each record is given its own depth scale (zA, zB, zC . . . )
against which proxy data are defined.

(2) Each record is assigned its own site-specific timescale (tA, tB, tC . . . )
which is defined to be exact. Thus, for example, A might be a terrestrial
site, B might be the IntCal radiocarbon record, and C the Greenland ice
record. The age-model for the terrestrial site provides the specific time-
scales for that site and IntCal and Greenland have their own reference
timescales.

(3) A number of different time-transfer functions, are defined either as part
of age-depth models, or derived from other specific synchronisation in-
formation. For example, the age-depth models for a terrestrial site, with
its associated uncertainty, give time transfer functions relating tA to tB
(GAB(tA)) and 10Be could be used to relate the IntCal (tB) and Green-
land (tC) timescales (Muscheler et al., submitted) through a time-transfer
function (GCB(tC)).

(4) The age-depth models and time-transfer functions are used to provide
the age and uncertainty of each point in every record in relation to every
timescale within the network, taking into account any depth uncertainty
in the proxies. All possible paths through the network are explored and
the path which gives the lowest uncertainty at any particular period is
selected. Thus, for example, a terrestrial record dated by radiocarbon will
have dates in the local timescale with an uncertainty only dependent on
depth uncertainty of the proxies; it will have dates in the IntCal timescale
which will be the same but will now incorporate the errors associated
with the radiocarbon calibration and age-depth modelling; it will have
dates on the Greenland timescale which will be slightly different and will
have greater uncertainties because there is uncertainty in the relationship
between IntCal and Greenland.

(5) Finally, the depth scales (where relevant) from all records are calculated
for all proxy data in all records. Thus, for example a particular point in
the Greenland record where there might be a climatic excursion can be
related to the depth in a specific terrestrial record (but with associated
uncertainty from the extended chain of inference). This allows users to
see if events are, within errors synchronous in different records, without
making any such assumptions.

There are a number of shortcomings in this approach which should be kept in
mind when using the results from the integration:

• The age-models are assumed to be correct within their stated uncertainties.
• There are approximations of linear interpolation involved.
• For propagation of errors, a first order approximation is used which assumes

a well-behaved relationship between timescales and depth.
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• Some information is discarded because only the highest precision linkage
in the network is used; this is conservative and, unless the uncertainties by
different routes are similar, is unlikely to be very significant.
• In principle, there is a danger that the monotonic nature of the timescales

might not be preserved. If there are linkages between timescales that are
only significant in particular periods (for example near tephra), then the
timescales could have discontinuities in these regions. In practice this does
not seem to be a major problem and is only likely to be so if there are data
which are seriously discrepant.

However, despite the simplifications made, the approach set out here provides
a powerful way to pull together the available information in a comprehensive
way. It has the advantage that mathematically it is simple enough that all
the calculations can be made dynamically as a range of different datasets is
considered.

3 Database structure

In order to allow for practical integration of chronologies, it was considered
essential to have a database in which the relevant information could be col-
lected. This means that new data can easily be added, existing data stored
and shared between users.

The database structure closely follows the requirements laid out for integration
above and is summarised in Figs. 3 and 4. There are eleven main tables in the
database:

• sites : this table holds geographical information such as site location and
type for the database; each site can, in principle, have more than one record
which allows for multiple cores, different speleothems within the same cave
etc.; each site can have multiple references which describe the site generally
(not specific records).
• records ; this holds information on the records themselves and provides the

anchor for all of the data associated with that record; each record has linked
to it lists of dates associated with it and one (and only one) age-depth model
which is used to relate the record to others; there can be any number of
series of proxy data associated with the record; there can also be multiple
references, at least one of which should provide the background to the age-
depth model chosen.
• dates : this is primary dating information associated with a record and pro-

vides a simple list of dates of different types against depth; these data are
not directly used in the integration of timescales, but is a useful resource
should people wish to update age-depth models with new information (such
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as updated radiocarbon calibration curves).
• age-depth: this provides the information for linking age with depth for a par-

ticular record; this is the data which provides the age-depth model as out-
lined in section 2.2 above; details of the age-depth model (reference timescale
etc.) are stored at record level.
• series list : this table is just a list of the proxy data series associated with

the record; there will usually be at least one data series, but there might
be several, each with different sampling intervals; each series can have data
for multiple different proxies and associated information; where there are
climatic reconstructions made from proxies the method used for these is
shown at series level; each proxy data series can have multiple references.
• proxies : this table contains the actual proxy data against depth for the

records and any reconstructed climatic parameters. The database allows
the user to mark data as null so that breaks in data series can be identified.
• relationships : this table holds the global list of time-scale relationships

(time-transfer functions) available to link a pair of records; together with
the age-depth models, these provide the linkages in the integration network;
each relationship has one reference, which should provide an explanation of
the relationship and the underlying data (or references to that data).
• time-transfer : this is the time-transfer data for a pair of records as described

in section 2.3 above.
• events : this table provides a summary of the main INTIMATE event stratig-

raphy (currently N. Atlantic region only); each event can have multiple ref-
erences associated with it and its timing must be specified in terms of a
specific timescale; within the integration this event stratigraphy is treated
like a special record.
• eruptions : as for the events table, this contains a list of key eruptions vis-

ible in a number of sites; each eruption has a single date estimate associ-
ated with it against one of the reference timescales and a reference from
which this date is taken; this table is shared with the RESET 4 database
(Bronk Ramsey et al., 2014) where there is much more information on the
eruptions, composition of tephra and associated references; the eruptions
in this database are primarily those relevant to the European and North
African regions which were the focus of the RESET project.
• references : this table holds all the bibliographic information associated with

the data stored in the data; the principle here is that everything in the
database should be traceable to published sources and that when data are
extracted from the database a comprehensive bibliography is provided to
go with that data.

4 Response of Humans to Abrupt Environmental Transitions; see http://c14.
arch.ox.ac.uk/reset/
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sites :



site→



refs

records :



record→



refs

dates

age-depth

series list :



series→

refs

proxies

series . . .

series . . .

. . .

record . . .

record . . .

. . .

site . . .

site . . .

. . .

Fig. 3. The main structure of data in the database relating to temporal records. In
this figure [ brackets denote arrays and { records within the database; the term refs
refers to a series of links to the references table (effectively citations).

4 Database implementation

The database described here, uses the open-source MySQL package and a
web interface based on php. The database is available online at https://

c14.arch.ox.ac.uk/intimate/db.php. The database is currently read-only
for those not involved with the database development and the INTIMATE
project.

4.1 Navigation of the database

The interface of the database is designed to be intuitive to use. There are
essentially three different methods that can be used to navigate around the
database: firstly, from the front page there are a number of links to frequently
used pages (see Fig. 5); secondly, the menu bar at the top of the database
page allows users to go to key pages wherever they are in the database; finally,
almost all of the data presented in the database are hot-linked so it is easy to
browse the information available.

The menu of the database has four main components:

16

https://c14.arch.ox.ac.uk/intimate/db.php
https://c14.arch.ox.ac.uk/intimate/db.php


relationships :



relationship→

ref

time-transfer

relationship . . .

relationship . . .

. . .

events :


event→

{
refs

event

. . .

eruptions :


eruption→

{
ref

eruption

. . .

references :


reference→

{
ref

reference

. . .

Fig. 4. The structure of the supporting tables in the database. See caption of Fig.
3 for further explanation and also note that the term ref refers to a single link to
the references table whereas refs refers to multiple such links

Fig. 5. Home screen of the database developed for the chronological working group
(WG1) of North Atlantic INTIMATE.
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• File allows users to print, save (if they have permission) and export data
from the database; they can also log out of the database or change their
password from here.
• Edit allows users to select details of their search, and if they have permission

to set the database to edit mode.
• View gives access to different views of the displayed data
• Sites gives access to a list of sites, records and data series
• References allows users to view references by first author or year
• Events lists the INTIMATE event stratigraphy and volcanic eruptions (cur-

rently N. Atlantic region only)
• Tools gives access to a number of tools, including the most important IN-

TIMATE ‘Time search’.

The main pages of the database reflect the structure of the database described
in section 3 above. In general, the information is presented in a series of data
panes. For example, looking at the page for a specific record (see Fig. 6),
provides a summary of the data for that record and a series of tabs with
information on series list, age-depth model, the dates that have been used for
the age-depth model, tephras found in the record, any relationships between
this record and others, and finally a list of references for this record. At the
bottom of the page it shows a full list of references for the site, record and
associated data series.

Any items shown in blue on the database page are hot-linked and can be used
to get more detail on that item. In addition, the / button allows users to go
to the parent of any page (so for example from a record page to the associated
site page).

All of the chronological information stored on the database is internally stored
as astronomical years. However, this may well not be the form in which the user
wishes to use it. For this reason the database can be set to display chronological
information in one of three formats: Astronomical years (CE), b2k (specifically
intended for use with GICC05) and calBP (which is defined to be before AD
1950). Wherever it is relevant it is possible to change which format is used by
using the View menu. The database shows in the top right which form of date
is being employed (for example ‘t=calBP’).

The pages of the database will normally just present data in tables. These
data can be exported using the File menu; there is a choice of formats of
which csv is probably the most useful; all of the different data tables shown
will be exported.

In many cases users may wish to show the data graphically. This can be done
using the View menu (see sections 4.3 and 4.4 below).
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Fig. 6. Example record page from the INTIMATE database.

4.2 Integration of data from a specific time-period

The key motivation behind this database is integration of records, and so
this is the most important aspect of the package. To use this facility users can
either use the ‘INTIMATE time search’ link on the front page of the database,
or use the menu system [Tools > Time search]. This will pull up a list of the
data series in the database and the provide the option to select a time period.
Here the time slice of interest should be entered in the ‘From’ (oldest) and
‘To’ (youngest) boxes in the active date format. It is also possible to select
which data series to draw data from, using the select boxes down the left. If
none are selected the assumption is that data from all data series are required.
After this selection the user should press the [Search] button. This will pull all
of the relevant information from the database, but at this stage no integration
of the data has taken place.

Next users can either press the [Plot] button, or use the [View > Plot data]
menu item. This will tell the browser to integrate the timescales using the
mathematical methods outlined in section 2 above. There may be a slight
delay while the calculations take place before the plot window is opened.
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Fig. 7. Plotting interface for the database. See Fig. 8 for further details.

4.3 Plotting data

All plots are generated dynamically and use plotting routines which have been
developed for OxCal (Bronk Ramsey and Lee, 2013) but with additional tools
specifically for use with this database. There are a number of different database
pages from which data plotting is possible.

The plotting of integrated data is the most important aspect of the database
(see details of the integration process in the previous section). The user is pre-
sented with a plot of proxy against a default timescale (for example GICC05).
There are also two additional plots shown, one displaying the INTIMATE
event stratigraphy, and the other presenting the tephras that are recorded for
this time interval (see Fig. 7; these plots should only be used if they are ap-
propriate for the region of study. Uncertainties (1σ) in time, depth or proxy
values are displayed as ribbons along the data series.

The top panel of the plotting tool has items specific to this database:

• There is a drop-down selection list at the top of the plot which allows the
user to select a different timescale or depth scale to use to plot against, and
another one which allows different units to be selected for date or depth.
On doing this, the user will see that the uncertainties in the time or depth
associated with the different proxies change and that there might be small
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changes in absolute dates on the different time-scales depending on how they
are related. This is the main way of displaying the output of the integration
of timescales.
• Users may wish to hide some of the plot panels which can be done by

selecting the proxy name and pressing the [-] button; the plot can be restored
by pressing the [+] button. As a default, all proxy parameters are plotted
together and so, for example, if several different records each have δ18O
data-series, these will all be shown together; in some instances, this may
not be convenient and so specific plot panels can be created for proxies
from individual records by selecting the record and proxy and then pressing
the [+] button (and removed by pressing the [-] button).
• Finally, there is a series of buttons which allow users to change the orien-

tation of the plots, and a globe button which shows the records on a map
(see next section).

Plots can also be generated from a number of other pages in the database. In
particular plotting data for a particular record will just plot the proxies for
that record against the directly related time and depth scales (see Fig. 8). The
same can be performed for a specific series too.

The remainder of the plotting window is common to all plots from this database,
the RESET database, or some plots from the OxCal program. Manipulation
of the plots can be done using the menu system:

• File: Most importantly this allows the user to save the plot (normally down-
loaded) as a pdf, svg or png format graphics file. It is also possible to print
the plot (which, depending on the operating system, may enable it to be
saved as a pdf file). The other important feature is the ability to export the
data; this will export all of the data associated with the plot to a single csv
file which can then be manipulated with a spreadsheet. This is another way
to use the output of the timescale integration performed by the database.
It is also possible to set some options such as relative font size and spacing
here, or to reset these to defaults.
• Edit : This has options related to the data shown on the plot. Datasets can

be selected for display and the line, marker types and colors used can all be
set here. The data can also be viewed in detail and exported one dataset
at a time (to csv format). In principle, data can also be imported through
the edit option, but note that this will only display data on the plots and
will not perform the integration of timescales which is part of the database
package.
• View : This is where details of what is plotted can be altered, including axes

and labels.
• Format : Enables control over plot dimensions, overall colour scheme and

type of map (see next section).
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Fig. 8. This shows typical output from the database, showing the loss on ignition
(LOI) data from Kr̊akenes (Lohne et al., 2013) alongside the δ18O record from
NGRIP (NGRIP members, 2004; Rasmussen et al., 2006). The upper plots are
shown on the GICC05 timescale (Rasmussen et al., 2006), while the lower plots are
on Kr̊akenes’s own timescale (based on IntCal09; Reimer et al., 2009). The different
temporal uncertainties, when looked at from these different perspectives, are the
key output from the integration. Note that the event stratigraphy uncertainties are
also different between the two plots. Similar plots could also be obtained: for exam-
ple, against the IntCal09 timescale or against depth in the Kr̊akenes record. Note
that, for example, the Vedde Ash (just before 12000 cal BP) has high chronological
precision in both timescales as this tephra is found in both records.
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In addition to being able to control axes through this menu system, the data
can also be manipulated by clicking and dragging. If the user clicks on a
plot they can reposition the data axes dynamically, allowing them to explore
a dataset in more detail. Using the [Shift] key while dragging will allow the
scale to be expanded or contracted. Using the [Alt] key while dragging changes
the size of the entire plot.

4.4 Mapping data

In order to help with the exploration of data in its geographic context, the
database also has rudimentary mapping functions. The mapping is provided
as part of the plotting routines (see previous section), with an underlay map.
The maps themselves can either be a simple world map which is provided
in svg format, or can use any of the main GoogleTM map formats which are
directly linked from the Google website. The GoogleTM maps are fine for screen
display, and can be printed, but cannot be saved as plots for further editing.

Mapping can be used for a number of different purposes. It can be used just
to show the location of sites or records within the database. In this form the
points on the map are also hot-linked back to the database; clicking on the
marker for a particular site in the map will open a new database page showing
all of the data from that particular location.

Given that the focus of the database is on timescales, and associated proxy
data, the main purpose of mapping is to show proxy data for particular time-
slices. To view data which come from integration of timescales (see previous
two sections), or from a particular record, users first plot the data (previous
section) and then press the globe button on the top right. This allows them
to choose the time range that they are interested in, and the time increments
for any multiple plots. Optionally, they can also adjust the marker size. They
are then presented with a map which shows the sites and colour codes them
according to the value of a particular proxy at a particular time (the proxy can
be chosen from the top panel, as can the timescale used). There is a slider at
the bottom of the plot which can be used to move through the timescale, and
buttons which allow the user to animate this process, showing how the proxy
varies over time at different sites (see Fig. 9). Within the plotting program
the menu item [View > Multiplot] can be used to show the map at a range of
time-slices. The slider at the bottom of the page then needs to be positioned
to choose the starting time for the set of maps.
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Fig. 9. An example map generated directly from the database. The plot shows the
reconstruction of Warmest Month Temperature (WMT) in ◦C for a number of sites
(Watson et al., 2010; Birks et al., 2012; Brooks et al., 2012; Samartin et al., 2012;
Tóth et al., 2012; van Asch et al., 2012) in Europe at 13,360 cal BP (IntCal09
timescale; Reimer et al., 2009). Note that, because a colour scale is used, the un-
certainties in reconstructed temperature and timescale are not currently reflected
in these maps.

4.5 GICC05 to IntCal linkage

In practice the tools described here are made particularly useful by the ability
to quantify the linkage between the GICC05 and IntCal timescales.

The transfer function between IntCal and Greenland ice core (GICC05) time
scale is based on the variations in the incoming galactic cosmic ray flux that
produce globally synchronous variations in the cosmogenic radionuclide pro-
duction rates. These can be seen as variations in the atmospheric 14C concen-
tration as recorded in e.g. tree rings or as variations in 10Be concentrations
in ice cores. The variations can be used for very accurate 14C dating (Pear-
son, 1986) but also for comparing and transferring the time scales of different
natural archives. However, this exercise requires that the known geochemical
differences between the different radionuclides are accounted for before a time
scale comparison can be attempted.
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In the case of ice core 10Be records it is important to isolate the production
signal and minimize the climate influence. In a first approximation this is
achieved by calculating the 10Be fluxes (e.g. Yiou et al., 1997). Furthermore,
the average atmospheric residence time of 10Be of about one year needs to be
considered (Raisbeck et al., 1981). In the case of 14C the known influences of
the carbon cycle on the atmospheric 14C concentration have to be taken into
account (e.g. Siegenthaler et al., 1980). Here this is achieved by using a box-
diffusion carbon cycle model to reconstruct the 14C production rate (Muscheler
et al., 2005; Siegenthaler, 1983; Stuiver and Quay, 1980). However, the option
in this model for a direct exchange of CO2 from the atmosphere to the deep
ocean was not used. The results regarding modelled 14C variations are very
similar to results from more recent 3D carbon cycle models (Muscheler et al.,
2007). The resulting production record is corrected for the effects of a delayed
and dampened reaction of the atmospheric 14C concentration to production
rate changes.

The time scale transfer functions used here are based on the comparison of the
spliced GRIP and GISP2 10Be records (Finkel and Nishiizumi, 1997; Muscheler
et al., 2004; Vonmoos et al., 2006; Yiou et al., 1997) and the Intcal09 and Int-
Cal13 calibration records (Reimer et al., 2009, 2013). The time scales are
compared via the identification of the best agreement between the ice core
10Be and tree-ring based 14C production rate variations. Error estimates are
inferred from Monte-Carlo simulations where the records are varied within
their uncertainties before the best fit of the time scales is assessed (for details
see Muscheler et al., submitted). The maximum counting error of the ice core
time scale is taken into account in the process but not as a hard limit since
errors might come from either of the time scales involved in any transfer func-
tion. Continuous tree-ring based atmospheric 14C estimates are restricted to
about the last 14000 years. At the moment only these records allow reliable
estimates and unequivocal matching of the short-term atmospheric 14C vari-
ations. Therefore, the direct link between ice core and radiocarbon time scale
is presently limited to this period, beyond which counting errors must be used
to estimate uncertainty.

4.6 Technical details

The database has been designed to minimise server overheads so that perfor-
mance of the database can be maintained with many users. For this reason the
php code used for extraction of data from the database is fairly simple - and
its function is primarily to allow secure access to the data and to perform the
SQL searches on the database. The data from the database are then sent to
the user as javascript arrays and objects. All of the presentation and numerical
analysis of the data takes place on the client’s machine within the javascript
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engine of the user’s browser. This approach has several advantages: data only
have to be retrieved once and all further analysis or different presentation does
not require extra searches to be performed on the database, minimising the
effect of low connection speeds; furthermore the server itself does not have to
prepare data for presentation or do any numerical analysis, which improves
performance of the system with multiple users. However there are also some
disadvantages to this approach: the quantity of data being analysed can be
quite high and client computers without much memory, or with low perfor-
mance web-browsers may find that the system is slow to use, or cannot cope
with searches that attempt to integrate very large quantities of data.

If users want to see how this works in practice, they should try the time search
as explained in section 4.2 above and look at the page source. Here they will
see the raw data extracted from the database as a javascript data object.

The numerical analysis code is all written in javascript and is therefore openly
available. The main integration routines are all given in one file https://c14.
arch.ox.ac.uk/intimate/integrator.js

All of the graphics generated by the database are also generated dynamically
within the web-browser of the user. Again this has the advantage that these
processor intensive tasks do not slow down the server. The graphics use the
Scalable Vector Graphics (SVG) standard, compatible with most of the lat-
est generation web-browsers. The plots generated can be saved in this format
(editable with the open source Inkscape package or various commercial alter-
natives such as AdobeTM Illustrator), or can be converted to pdf or png format
using ApacheTM Batik toolkit installed on the server.

5 Further developments

The database as published here is a first attempt to bring together all of
the timescale information from the INTIMATE project and use it to present
associated proxy and inferred climatic reconstructions. Clearly, these ideas
can be developed further and the authors expect future advances to depend
on feedback from users allied to improvements in the generation of proxy
datasets. However, there are already a number of areas that are being actively
pursued to enhance the database:

• addition of datasets Clearly the data added at the INTIMATE data integra-
tion exercise in Blair Atholl was limited by what was available at the time,
in the right form, and also by the age and geographic range of the North At-
lantic INTIMATE group (see section 1). In principle, the approaches taken
here could cover other regions and time-scales. To some extent this would
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simply be a matter of adding further data. However, especially if the data
are to be used in different ways it may also be necessary to further develop
the integration methodology and search criteria.
• search criteria At present the search criteria are limited to time-range. How-

ever, as the database expands it will clearly be necessary to add other filters
and search tools that can make use of the data stored within the database.
Feedback from users of the database on what types of search would be useful
is encouraged by the authors.
• private data At present, all data within the database are presented to all

users on the understanding that the data have all been through the peer-
review process and have been published. However, it is clear that it would
be beneficial for users to input their own data, but without making the data
available to the community. This should help i) in the preparation of data
for publication, ii) for students engaged in research as part of their studies,
iii) help the workflow for getting new data onto the database.
• linkage with OxCal This database has deliberately been developed using

much of the same core code as OxCal, sharing the plotting package OxPlot
which is used for the mapping and graphics. The intention is to allow future
versions of OxCal to link to the database directly, allowing data from the
relevant time period to be plotted along-side radiocarbon calibrations and
age-models produced by OxCal. In this way, the INTIMATE database can
become a useful resource for people looking at environmental and archae-
ological information across this time period (the last 60 ka). In addition
it would help the generation of age-models for users’ own sites if it were
possible to use the dates records from the database to generate age-depth
models that could be run using OxCal automatically. The ease of record
comparison does of course also pose some additional risks: this might tempt
the user to choose age-models that agree with their understanding of the
underlying processes; ideally the choice of age-modelling approach should
be independently selected before comparison to other key records.
• time-transfer function generation At present, there is no automated way to

generate the kinds of time-transfer functions needed here. In principle, this
information could be extracted when two or more age-depth models are run
together and so a future development envisaged for OxCal is to provide a
simple means to extract time-transfer data in the format needed for this
database.
• fluxes Some data make most sense understood in terms of flux rather than

actual concentration. The ability to deal with this while changing between
timescales would be a natural extension of the methodology presented here.
• data presentation There are a number of ways in which the data presentation

might be further developed. Probably one of the most important would be
some form of interpolation (either via Kriging or inverse distance weighted
interpolation) between points for the mapping of reconstructed variables
for specific time-slices; this would allow more direct comparison with model
outputs.
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6 Conclusions

The approach taken here to integration of timescales makes use of what is
a fairly simple mathematical approach, involving linear interpolation and as-
sumptions of Normality in uncertainties. In this sense, what the tools set out
here do, is something which would be possible for any numerically able re-
searcher to undertake within packages such as R (R Core Team, 2014) or
MatLabTM, given sufficient time. Indeed, with particular records in mind it
might be possible to make even better use of all the available information.
The value of the methodology set out here is only realised in combination
with the database which provides the relevant data in a form already suit-
able for integration. By using a simple web-based framework that does not
require installation of any specialised software, this allows researchers to com-
pare what is happening in different records very quickly and thus makes it
possible to explore ideas and hypotheses interactively.

The database, as it is at time of publication, is necessarily a ‘work in progress’.
The database can be strengthened by the addition of more data from different
records and the collection of these data is the focus of others involved in the
INTIMATE initiative. In addition, because the overall framework outlined
here is new, there will undoubtedly be ways in which it can be improved both
in terms of the underlying methodology and the user-interface. However, it is
hoped that the database, as it is presented, will provide a useful tool for those
doing research in the late Quaternary.
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Tóth, M., Magyari, E. K., Brooks, S. J., Braun, M., Buczkó, K., Bálint, M.,
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